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1) Overview

Crystal Quest CritterEditor is a program designed to allow you to
customize the game "Crystal Quest” (© Casady & Greene Inc. 1987
and 1988). It allows you to change almost every conceivable aspect
of the game, while keeping its basic nature intact. With the
CritterEditor you can change the appearance of practically
anything that appears on the screen; you can replace the sound
effects with your own; you can speed things up or slow them down
- in all, there are over 1000 things that you can change ! You can
create stand-alone versions of the game or save your changes in
parameter files for later use.

For those of you who found Crystal Quest too difficult: revenge is
yours! You can give yourself bonus lives every 1000 points or put
only one Crystal on each wave but make it worth 30,000 points.
(As you can see, you can quite happily defeat the object of the game
with this program - but as if you'd do a thing like that 1)

For all of you who can sit playing a single game of Crystal Quest for
hours on end (until your intestines give up any hope of being
needed again, escape, and apply for a job as a draft excluder for
aircraft hanger doors), you can make the game as challenging as
you dare. Make parasites start at wave one and travel twice as fast
as you can, or make the gateway exactly the same width as your
ship.

2) Hardware and Software Requirements
Crystal Quest CritterEditor runs on a Macintosh Plus, Macintosh
SE and Mac II.

The CritterEditor can only modify copies of Crystal Quest marked
Version 2.20 or later. If your version of the game is an earlier one
than this, please contact Casady & Greene Inc. .

3) Program Basics

Before you do anything, make backup copies of both the game and
the Editor. Put the masters away in a safe place. You will probably
make mistakes building games and want to start over with a fresh
game. Don’'t use the master disks for any purpose other than

copying.

To run the program, select it from the Finder and choose Open
from the File menu, or double click on it. Selecting one or more
parameter files from the Finder and opening or double clicking on
them will run Crystal Quest CritterEditor and automatically open
those files. Parameter files are explained in section 4 below.

The program has only three menus. The first is the Apple menu

which, as usual, contains the credits for the program and your

collection of Desk Accessories. It also contains the item marked
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Help. When selected, this brings up a series of pages of
information which are largely similar to this manual. Clicking on
Next or hitting the Space Bar takes you to the next page; Previous
or the Delete key takes you back a page.

The File menu contains a series of commands to create new or
open existing parameter files and save into new or existing

eter files. It also has commands to work directly with copies
of Crystal Quest itself. These commands are explained fully in
section 4 below.

The Close item in the File menus closes the front-most window,
whether it be a Crystal Quest CritterEditor window or a Desk
Accessory.

In the file menu you will find the commands Revert and Revert to
Defaults. These change the contents of the current CritterEditor
window, restoring it to the state it was in when it was last saved or
to the default states respectively. The default state is that which
the game is in when it was originally shipped. In both cases the
program asks you to verify your choice, as it could well destroy all
of your customizations. Note that after a Revert To Defaults
command you have to Save the file to make the reversion
permanent.

Also in the file menu is the command Transfer to Crystal Quest.

This brings up a list of copies of Crystal Quest. Select the one

which you wish to run and either double-click on it, click on Run, or

press return or enter. If you have any changed files open, then you

will be asked whether they should be saved first. The copy of

?&Ft&lmmtﬂmtym selected will be run as if you had run it from
e Finder.

If you have a window open which corresponds to a copy of Crystal
Quest, then it will also have a Transfer button on it. This does the
same as selecting Transfer to Crystal Quest does but by-passes
the file selection process and automatically runs that copy.

When you quit from Crystal Quest after transferring to it, you will
be returned to the CritterEditor with the same windows open as
when you left.

The Edit menu is only used by Desk Accessories, and is dimmed
when a Crystal Quest CritterEditor window if front-most.

All windows that appear in the CritterEditor have four buttons in
common. These are Help, OK, and Revert to Defaults. Most
windows also have a Cancel button. These buttons are mostly self-
explanatory. The Revert to Defaults button are similar to the
commands in the File menu except that they only apply to the
contents of the particular window that they appear in. For
instance if you clicked on Revert to Defaults in the window for
editing Parasites, the images for the parasite and the data
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concerning its movement will be set to the default values, but all the
other information in the file will remain unchanged.

4) Files

The CritterEditor can work on two different sorts of files. One

are copies of Crystal Quest itself, the other are parameter files

created by the CritterEditor. The other very important difference

between copies of Crystal Quest and parameter files is that
er files can be distributed freely, while Crystal Quest may

not be distributed. You are quite free to post parameter files on

bulletin boards or give them to friends and user groups. Please do

not distribute Crystal Quest itself or a modified version of Crystal

Quest.

Unless you are running from a hard disk you should generally
save your customizations as parameter files and only install them
into Crystal Quest when you want to play. This is because
parameter files are not very long while Crystal Quest is about 128K
(note that the lengths of both these files increase substantially
when custom sounds are added). Another reason to use
parameter files is that if you have multiple copies of Crystal Quest
around, you don't know which one will be run when you double
click on a Crystal Quest game save file.

If you select New from the File menu, a new window is created. The
window corresponds to an un-named parameter file which starts
off containing default values throughout. This window can then be
saved as a parameter file (with Save as Parameter File ) or installed
into an existing copy of Crystal Quest (with Save into Crystal

Quest ).

Selecting Open opens an existing parameter file or a copy of
Crystal Quest and puts it in a window. You may then make any
changes that you want and, if it was a copy of Crystal Quest that
you opened, click on the Transfer button to try them out. However,
it is wise to keep a copy of the changes in a parameter file, so that
you may install other sets of parameters into this copy of Crystal
Quest without losing any data.

The Save item in the File menu either saves the window as a
parameter file or saves it into a copy of crystal Quest, depending on
which was done last, or where it was opened from.

Remember that the contents of parameter files cannot be tried out
until they have been saved into a copy of Crystal Quest. They are
for storage of sets of customizations only.

The suggested method of using the CritterEditor is to only keep a
few favorite customizations around as copies of Crystal Quest.
Save most things as parameter files. When you want to create a
new version of the game, start of with a new file, then save it into a
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copy of Crystal Quest. Keep it this way while you are playing
around with it, so that you can use the Transfer button to quickly
try out your changes. When you are finished, save it as a

parameter file.

All files (parameter and Crystal Quest files) can have a comment
attached to them. This comment can be read and edited by
selecting Get Info from the File menu when the window for that file
is open. The comment can contain anything that you want, for
instance a credit to the author of the file; a brief description of how
the file modifies Quest; a few hints for play; ideas for extensions to
the file etc. This comment is particularly useful if you're going to
post a Parameter file on a bulletin board. Remember that Crystal
Quest may not be posted on a bulletin board.

When the Get Info window is visible, you can Cut, Copy and Paste
text by using the usual Command-X, C and V combinations.

Each parameter file also has its own set of high scores attached to
it. If you revert a file to the defaults or start with a new file, then it
will use the High Scores from the unmodified game. When you
install a set of parameters into a copy of Crystal Quest, the high
score table currently in use is used to update the parameter file
that the was previously used to customize the game. In this way,
high scores are kept specific to their parameters so that they
remain meaningful. You needn't worry about what is happening
here though - it is all done automatically for you.

If you open a saved game while using different parameters to those
under which the game was saved, then you can play the game OK
but you cannot register a high score. This is to stop you from
saving a game using a really easy configuration, then re-open the
file in a more difficult version and get an artificially inflated high
SCOre.

When running a non-standard version of Crystal Quest, the game
display shows “Modified Crystal Quest” instead of just "Crystal
Quest”, so that you know that you are playing a customized copy.

5) Editing graphics

Crystal Quest CritterEditor allows you to change the shapes of
any of the objects that appear on the screen in Crystal Quest. This
can be done by pasting in images created by another graphics
program (e.g. MacPaint or MacDraw). The CritterEditor does
however have an Integral graphics editor which is quite sufficient
for most tasks. Whenever a shape can be edited an image of it
appears in the relevant window. Clicking on this image will bring
up the graphics editor, and the image can be changed. Each shape
actually has two parts - a black and white version and a color
version. The two versions of the shape should really look similar,
but they don't have to. If you are running on a Mac II set to at least
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16 colors then a pair of images will always appear, with the black
and white one on the left and the color one on the right. You will
notice that all images appear on a black background - this is
because they will appear against black in the actual game, so this
lets you see them as they will look when in use.

If you have color on your Mae II, we recommend setting it to 16
color mode. (Crystal Quest will automatically switch to 16 color
mode when it is run).

The graphics editor window is as shown below when you are
running in color (the gray boxes will appear in different colors).
The example shows it working on one of the images of Dumples.

| Copy from B/W || Copy te B/W |
[ Copy to all ][ Undo
[ Cut Enng

[ Paste Clear

| DK, Next shape || OK, Prev. shape |

[ Revert to defaults ]

( 0K )

{ Cancel _]

If you are running on a monochrome Mac or a color Mac II set to 2
or 4 colors then the window will look the same except that there
will be no color palette or Paint Can icon at the bottom of the icon
bar and the buttons marked Copy from B/W and Copy to B/W will
appear as Copy from Color and Copy to Color respectively.

Each image has a maximum size that it can be defined as, for
instance the maximum size of a bullet is smaller than that of a
nasty. This maximum size will be reflected by the size of the black
background in the window.

The window shows a “FatBits™ style view of the image and a
normal-sized view. In black and white, select the pencil to change
white pixels to black and vice versa, the eraser to erase areas to
black; and the paintbrush to paint larger areas with white. In color,
the paletie shows the current painting color by drawing a border
around it. Clicking on a different color makes this the current
painting color. The pencil changes pixels to the painting color
unless they where that color already, in which case it changes
Crystal Quest CritterEditor User's Manual - 5



them to black. The paintbrush paints larger areas in the painting
color, and the eraser functions in the same way as it does in
monochrome mode.

Many images are part of a group. A group of images is an
associated collection of i es that appear next to each other in a
window, for instance the four different images that make up a
Dumple or the left and right halves of the gateway. If the image
that you are working on is part of a group, then the Copy to all.
OK, Next shape and OK, Prev. shape buttons will appear. If the
group of images will be animated within Crystal Quest (for
instance the four images of a Dumple as opposed to the two images
for the portals) then another full-size view will appear next to the
Help button. This shows what the animation will look like, and
changes as you change the shape.

The lower icons (7 in monochrome mode, 8 in color mode) perform
operations on the entire image. The four arrows shift the image in
the direction of the arrow (pixels falling off an edge reappear on the
opposite edge). The next two icons flip the image horizontally and
vertically. The seventh icon inverts the image - this turns black
pixels to white and vice versa. Color pixels are swapped according
to the position of their color in the palette, e.g., a pixel in the color
that is second from the start of the palette will be swapped with the
color that is second from the end of the palette, etc.

The final icon (which only appears when in color mode) changes
every non-black pixel to the current painting color. This is
particularly useful as an initial move when coloring in a previously
monochrome image.

The buttons to the right of the image have the following functions:

Copy to BfW and Copy to Color copy the image to its counterpart,
whether that be monochrome or color. This means that after
creating an image in one mode, you can easily copy it over to be
touched up in the other mode.

Copy from B/W and Copy from Color get the image from their
counterpart, and are the reverse of the above.

Copy to All copies the image into all images of its group, both
monochrome and color. This is very useful when starting afresh
at the image of a nasty for instance. You can draw one image, click
on this button to duplicate it throughout the group and then make
detailed ¢ es to the other images. If you hold down the Option
key when clicking on this button, the image is only copied to the
images for your current mode. For instance, if you are working in
color, then the monochrome images will not be altered. Note that
the Copy to All button doesn't appear when you are editing an
image that doesn't belong to a group, for instance the shape for
mines or the bullet shape.
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Undo takes back the last change that you made. Clicking it again
re-does the change. Note that you cannot Undo Copy
to...operations.

Cut and Copy put a copy of the image into the clipboard. It can
then be pasted into another graphics editor window, the
scrapbook, a separate drawing program or anywhere else you
might want. Cut clears the image to black afterwards.

Paste replaces the image with a picture from the clipboard. This
picture can come from another graphics editor window, the
scrapbook, a separate drawing program, etc. Normally the picture
is placed with its top-left corner aligned with the top-left corner of
the image and is clipped to the maximum size of the image.
However, if the Option key is held down when Paste is clicked on,
the picture will be scaled to fix the maximum image size (very rarely
useful).

Clear clears the entire image to black.

OK., Next shape accepts any changes that you have made to this
shape, and takes you to the next shape in the group. Holding down
the Option key while clicking here copies the current shape into
the next one.

OK, Prev. shape accepts any changes that you have made to this
shape, and takes you to the previous shape in the group. Holding
down the Option key while clicking here copies the current shape
into the previous one.

Note that hitting Cancel only cancels any changes that you made
to the image you were editing. It does not cancel any changes made
by clicking on a Copy to... button. However clicking on Cancel in
the window that displayed the images originally will cancel the

change.
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6) General editing
When you open a file or create a new one, a window will appear that
looks like this:

e trystal luest =———————==um|

Choose a subject: [ Transfer | [ Help )
[ General | AR S ) [ Nasties |
[ Wave data | | Crystals | [ Time bonuses |
Smart bombs | (Euplosions | . [ Sounds |
Demo [ Colors | [ Tesks |

The Transfer button only appears if the file is a copy of Crystal
Quest. The transfer button does not appear for parameter file (see
section 3).

This window shows you twelve categories to choose from. Clicking
on one of the buttons brings up a dialog box that gives you a
further choice of what to edit, or actually change images and data.
The following twelve sections describe each of the categories.
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:6.1) General
This is where you edit things that don't fall into the other
categories! You will see a window like this:

General | Help ]
Uersion name

Start from wave | 1

Click on pictures to edit
Mine:

Height of
. lleft portal

L

E3

Height of |
right portal

P

Right side of gateway:

=

Left side of gateway: Right portal:

Left portal:

[

[ Revert to defaults | ( Cancel

Centre of gateway:

The version name is a string which will appear in brackets after the
version number when you run the game. You may put anything
here to identify this particular customization (eg a name, number,
date, flavor of ice cream, etc).

The Start from wave box allows you to set the game to start at a
wave other than 1.

The scroll bars let you change the heights of the portals (the
portals are the things from which the nasties spurt out). The
position of the thumb on the scroll bar corresponds to the position
of the portal on the screen.

If you change the image of the center of the gateway, make sure
that you keep it wide enough to get your ship through | When

Crystal Quest draws the center of the gateway, it is vertically
aligned so that its top lines up with the top of the left side of the

gateway.
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:6.2) Ship
This window lets you change information about your ship and
bonus lives.

— e ———

Your ship etc [ Help ]

Number of lives at start of game Click on picture
Max speed of ship o to edit ship:

Bonus lives Band #1 Band #2 Band #3 Click on picture

Iinterval i]ﬁnnn " 40000 " 75000 to edit shot:
End of band |I[I |i 25 l n

=

[ Revert to defaults | ( Cancel |

Control sensitivity

The Number of lives at start of game box sets the number of lives
that you start out with (I bet you couldn't have guessed that). The
Max speed of ship bar sets the limit to your ships speed. Setting
this to the right allows you to go faster. The Control sensitivity bar
changes how far you have to move the mouse to make the ship go
at a certain speed. If you push this bar all the way to the left, you
will have to move the mouse around as though you were stirring a
cauldron to get anywhere; with it to the right just breathing on the
mouse will send your ship flying.

Note that when Crystal Quest checks to see whether your shot
has hit a nasty, it only checks the top-left hand corner of the shot
(for reasons ﬂfspeﬂd],&nmakmgynmshutshlgmﬂﬂnlyaﬂ'mtmﬁ
graphics — it will not be any easier to hit things.

The bonus lives are split into three bands of waves. The first
interval is the number of points between each bonus life up to the
end of that band. The end of the band is the last wave to which that
band applies. The second interval is the number of points between
each bonus life to the end of that band. The third interval is the
number of points between each bonus life from then on. Note that
any amounts entered in the interval boxes will be clipped down to
the nearest 1000.
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:6.3) Nasties

When you click on the Nasties button you will get a window which
looks like the one below. This window lets you choose a nasty to
edit. If you are running in color, then the images will be the color
ones.

lﬁ:liﬂ: on a nasty to edit

S—
e

Note that clicking on Revert to Defaults applies to all nasties.
Because of the gravity of using these buttons, you are asked to
verify your choice before the reversion is performed.

When you click on one of the nasties, a window specific to that
nasty comes up. The next thirteen sections explain each of the
nasties in turn.

Shrapwarden |  Parasite

[ 0K )

[ Revert to defaults |
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::6.3.1) Annoyers
The window for Annoyers is as shown below:

Annoyer | Help J
Click on image
Points scored to edit Annoyer

Speed

Direction changes

.[ 0K

o S

—

| Revert to defaults | [ Cancel

The Points Scored box contains the number of points you get when

you kill an Annoyer (by shooting, ramming, or smarting it). Note
that the points value can be negative (see section 8). The four
images are cycled through as the Annoyer moves around,
resulting in an animation effect. Clicking on an image brings up

the graphics editor, allowing you to change or copy it. If you click
on Copy to all in the graphics editor window, all three images of the

Annoyer are set the the one being edited.

The Speed bar refers to the maximum speed at which the Annoyer
can move. Moving the thumb to the right speeds it up, to the left
slows it down.

The Direction changes bar refers to how often the Annoyer
changes direction. Moving to the left makes it move more in
straight lines, very seldom changing direction; to the right makes
it change direction practically all the time - i.e., it jitters about
maniacally (but doesn't tend to get anywhere).
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::6.3.2) Worriers
The window for Worriers is as shown below:

Worrier | Help

Click on image t
Points scored -uft ll.lnn'larg "
Speed ElE

Direction changes

Homing instinct

Click on image to

g edit shot
Fire rate ﬂ
L 0K
[ Revert to defauits | L Cancel

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar, and the images, please refer to Annoyers
(section 6.3.1).

Clicking on the image of the shot allows to edit it. Note that
only the top-left hand corner of the shot is used in collision
detection (see note about your shots in section 6.2).

The Homing instinct bar refers to how likely it is that the Worrier
will steer towards your ship when it changes direction. Moving the
bar to the left means that its direction changes will always be
random. To the right means that it will always steer towards you.
Note that it only moves in your general direction, not straight at
you as Tentawarbles and Parasites do. Note also that the effect of
this parameter is closely linked to the setting of the Direction
changes bar, as the move towards you can only be made when a

direction change is being made.

Setting both the Direction changes and Homing instinct bars
completely to the right turns Worriers into sort of shooting
Parasites. Now that is nasty.

The Shot Speed bar refers to the maximum speed of of bullets that
Worriers shoot. The Fire rate bar controls how often they fire.
Note that even when the bar is set to its right-most limit (shoot
practically all the time), their shooting is limited by the maximum
number of missiles allowed in the current wave (see section 6.4)
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1:6.3.3) Dumples
The window for Dumples is as shown below:

Click on image
to edit Dumple

Points scored

Min hits to kill 2
Mau hits to kill 9
Max number on screen 3
Speed

Speed changes

Direction changes

[ Revert to defaults |

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar and the images, please refer to Annoyers
(section 6.3.1).

The Speed changes bar controls how rapidly Dumples can change
speed. Putting it to the left means that they tend to move evenly,
moving it to the right makes them speed up and slow down
constantly.

The Min hits to kill and Max hits to kill boxes denote how many
shots it takes to kill a Dumple. When a Dumple is created, it is
given an energy level somewhere between these two values. Each
time you hit it, it loses one energy level. When it runs out of energy,
it dies. Hence to make Dumples always die from your first shot, set
both the minimum and maximum to 1.

The Max number on screen box refers to the maximum number of
Dumples that can appear on the screen at one time. This is needed
because Dumples tend to stay around for a while as they are
difficult to kill, so in a wave that is meant to contain a mixture of
nasties, if they were unlimited in number they would tend to
dominate the screen before long. Note that the number on screen
is also limited by the Max number of nasties setting for the current
wave (see section 6.4).
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1:6.3.4) Pests
The window for Pests is as shown below:

Pest ( Help
Click on image
Points scored to edit Pest .

Click on image to

Speed

Direction changes

edit mines
Mine drop rate H
[ 0K )
[ Revert to defauits | | Cancel ]

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar, and the images, please refer to Annoyers
(section 6.3.1).

The Mine drop rate bar refers to how often the Pests will drop their
mines. Moving it to the right makes them drop as often as they
can, to the left: hardly ever. Note that Pests can only drop one
mine for each crystal that has been picked up, so that even when
this bar is set completely to the right, the number of Pest mines on

a wave can never exceed the number of crystals collected so far that
wave.

If you are working on a color machine, remember that the image of
the Pest's mine has its colors constantly changed by Crystal
Quest when it is drawn.
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+:6.3.5) Huskets
The window for Huskets is as shown below:

Husket ( Help

Click on image to

ints scored
- edit Husket

Speed e

Direction changes A W A

Homing instinct O o) E

Click on image to

Shot speed o] i W S edit shot

Fire rate o) B [

[ Revert to defaults ]

Huskets can be thought of as shooting Worriers (see section 6.3.2).

Moving the Shot Speed bar to the right increases the shot speed.
Moving it the left, slows down the Husket's bullets.

Moving the fire rate bar to the right increases the number of shots.
Moving it the left, slows down the Husket's trigger finger.
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::6.3.6) Banes
The window for Banes is as shown below:

T

Bane ( Help ]

Click on image to

Points scored edit Bane

Direction changes

Shot speed S Click on image
to edit bombs

Fire rate A J e e o B
ke Hic- R el s H - - - H {'}

DK
| Revert to defaults | Cancel

The Points Scored box contains the number of points you get when
you kill a Bane (by shooting, ramming, or s it). Note that
the points value can be negative (see section 8). The four images are
cycled through as the Bane moves around, resulting in an
animation effect. Clicking on an image brings up the graphics
editor, allowing you to change or copy it. If you click on Copy to all
in the graphics editor window, all three images of the Bane are set
the the one being edited.

The Speed bar refers to the maximum speed at which the Bane can

move. Moving the thumb to the right speeds it up, to the left slows
it down. :

The Direction changes bar refers to how often the Bane changes
direction. Moving to the left makes it move more in straight lines,
very seldom changing direction; to the right makes it change
direction practically all the time - i.e., it jitters about maniacally
(but doesn’t tend to get anywhere).

Moving the Shot Speed bar to the right increases the shot speed.
Moving it the left, slows down the Bane's bullets.

Moving the fire rate bar to the right increases the number of shots.
Moving it the left, slows down the Bane's trigger finger.

Crystal Quest CritterEditor User's Manual - 17



1:6.3.7)
The window for Zarklephasers is as shown below:

Zarklephaser | Help 3

Points scored Click on image to

edit Zarklephaser

. -
-

Click on image

Avoidance
Speed
Avoidance speed

Direction changes

Shot speed to edit shots
Fire rate .

( 0K )
[ Revert to defaults [ Cancel ]

For explanations of the Points Scored box, the Direction changes
bar, the Shot Speed bar, the Fire rate bar, and the images, please
refer to Annoyers (section 6.3.1) and Worriers (section 6.3.2).

Zarklephasers move in a way subtly different from other nasties.
They will tend to try to avoid you, preferring to shoot at you from
as far away as possible (the wicked little devils). They are especially
at home when hiding in comers, merrily shooting at you. Setting
the Avoidance bar further to the right makes them do this far
more prominently. Note that, like the homing instinct of Worriers,
Huskets, and Trimpets, the Avoidance setting is directly linked to
the Direction changes setting, as they can only decide to avoid you
when they have already decided to change direction.

They have two different speed settings, marked Speed and
Avoidance speed. The former is used when they are moving
randomly, and the latter when they are avoiding you. If you put
the Direction changes and Avoidance bars to the right, and the
Speed bar quite far to the left, then they become terrified of you,
and you can herd them around the screen as though you were a

sheepdog.
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::6.3.8) Menaces
The window for Menaces is as shown below:

Menace [ Help ]

Click on image to
edit Menace

Points scored 250

Speed

Direction changes

Fire rate
Laser speed
Maximum length

Average length

Revert to defaults ]

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar, the Fire rate bar, and the images, please
refer to Annoyers (section 6.3.1) and Worriers (section 6.3.2).

The other three bars control the Menace's laser beams. Laser
Speed sets the speed at which the laser beams come out of the
Menace, Maximum Length is the longest that a laser beam can
reach (at the left-most they are very short, at the right-most they
can span the entire screen) and Average Length sets the likelihood
that a beam can reach this maximum length. Set to the left means
that the Menace will hardly ever fire a laser that reaches its
maximum length, to the right makes the beams practically always
go as far as they can.
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::6.3.9) Trimpets
The window for Trimpets is as shown below:

Trimpets | Help

Click on image to edit
Maving Hibernating

Homing instinct
Hibernation time

Mak number on screen

| Revert to defaults |

For explanations of the Direction changes bar and the images
please refer to Annoyers (section 6.3.1); for the Homing Instinct
ba,r see Worriers (section 6.3.2); for the the Max number on screen
box, see Dumples (section 6.3.3).

Trimpets don't have a Points Scored box as they can't be killed
(except by smarting, when they score zero).

They always move horizontally or vertically at a speed between the
values of the Minimum speed bar and the Maximum speed bar.

The Hibernation length box gives the time, in seconds, for which
they hibernate when shot. If they are shot again while
hibernating, their timer is reset to this amount.

Note that there are two sets of images, one for their normal self
and one for when they are hibernating.
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1:6.3.10) Tentawarbles
The window for Tentawarbles is as shown below:

Tentawarble ( Help ]

Click on image to

Points scored edit Tentawarble

Normal speed
Homing speed

0K |

Cancel ]

[ Revert to defaults |

For explanations of the Points Scored box, the Direction changes
bar, and the images, please refer to Annoyers (section 6.3.1).

Tentawarbles usually move about randomly, at a speed governed
by the Normal s bar. However, when your ship's speed drops
below a value set by the Homing threshold bar, they home in
directly at you at a speed set by the Homing Speed bar. If the
Homing threshold bar is set to the left, then you have to
practically stop dead for them to home in; while if it is set the the
right, then you have to be moving quite fast to prevent them from

going for you.
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::6.3.11) Shrapwardens
The window for Shrapwardens is as shown below:

Shrapwarden | Help ]

Click on image to
edit Shrapwarden

Click on image to

edit shrapnel
Shrapnel count 16 .
.+

( 0K )

Revert to defaults | [ Cancel ]

Points scored

Speed

Direction changes

Shrapnel speed

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar, and the images, please refer to Annoyers
(section 6.3.1).

The other information refers to the shrapnel that comes from
them when they are hit. The Shrapnel speed bar controls the
speed at which the bits of shrapnel travel, and the Shrapnel count
box sets the number of bits that they blow up into (up to a
maximum of 64). Remember that too many pieces of shrapnel will
slow the machine down considerably, and that shrapnel moving
too fast can “skip over™ your ship (see section 8).

There can only be one exploding Shrapwarden at a time. If one is
already blowing up when you shoot another one, the first pieces of
shrapnel will disappear as the second one blows up.
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::6.3.12) Parasites
The window for Parasites is as shown below:

Parasite ( Help ]

Click on image

Points scored to edit Parasite

Speed

Direction changes

| Revert to defaults |

For explanations of the Points Scored box, the Speed bar, the
Direction changes bar, and the images, please refer to Annoyers
(section 6.3.1).

Parasites always home in on you, however, if the Direction
changes bar is set more to the left, then they won't adjust their
direction towards you so often, so they become less competent at

following you.
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::6.3.13) Bonus Crystals

Yes, alright, alright, Bonus Crystals aren't really all that nasty.
But when you think about it, aﬁﬂu so often get killed chasing after
one that they are quite nasty after all. It's just that they kill you by
proxy.

The window for Bonus Crystals is as shown below:

Bonus Crystals L Help i

Click on image to
edit Bonus Crystal

B B
B B8
| DK

[ Cancel

Minimum score

Maximum score 50000

Speed o G

Direction changes [Q[] |

[ Revert to defauits |

or explanations of the , the Direction changes
the images, please refer to Annoyers (section 6.3.1).

The Direction changes bar is usually set to the left, as Bonus
Crystals tend to move in straight lines most of the time. Setting it
more to the right makes them very hard to catch, although if it is
too far to the right, they don't tend to get anywhere, so this can
make things easier.

When you get a Bonus Crystal, you get a random number of points
between the values in the Minimum score box and the Maximum
score box. Note that any values entered here are rounded down to
the nearest 1000. Also remember that you can enter negative
values here (see section 8). The point value of a Crystal cannot be
between -10000 and 10000 however, so any values between -
10000 and zero are rounded down to -10000, and anything from
zero to 10000 is rounded up to 10000. For instance, if you entered
-50000 for the minimum score, and 50000 for the maximum
score, the value of a Crystal could be in the range -50000...-10000
or 10000...50000.
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:6.4) Waves
When you click on the waves button, you get the following dialog
bax, with a button for each of the 40 waves:

Wave data [ Help Tv
80000

Revert to defaults ]

Re?:w:umher that the data for wave 40 applies to all waves after that
as ,

Clicking on the Revert to defaults buttons verifies your request
first, as they operate on all 40 waves at once.

When you click on a wave button, you get another dialog box
showing you all of the parameters for that wave., This window
looks like the one below which, as an example, shows wave 25.

Data for wave 25 [
Number of crystals Annoyer
Number of mines 15 = SN
Dumple
- Pest
Max number of
0 spm:ru_lt H Husket
Max value of specials 10000 Bane
Zarklephaser
Max number of missiles 15 l Menace
Max number of nasties 13 g
Tentawarble
T . Shrapwarden
Smart bomb frequency QF T [o Besasins

o JEEEE
| DK, Newt wave | |

( Revert to defaults | [ 0K, Previous wave | [

Gateway speed Bonus crystal
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The Number of crystals box sets the number of crystals to be
collected on that wave and the Number of mines box sets the
number of mines on that wave. The Max number of specials box
controls the maximum number of special bonuses that can appear
on that wave - the actual number will be a random number between
zero and this value. The Max value of specials sets the highest
points value that they can attain.

Note that the total of the number of crystals, mines and maximum
number of specials cannot exceed 95.

The Max number of missiles box sets the maximum number of
nastie's missiles that can be on the screen at one time and the Max
number of nasties box sets the maximum number of nasties that
can be on the screen.

The Smart bomb frequency bar controls how many smart bombs
might appear on this wave. At its left most setting, no smart
bombs will appear; at its right most setting, up to 5 smart bombs
can occur.

The Gateway speed bar controls the speed of horizontal movement
of the gateway. At the left the gateway doesn’'t move, while at the
right it chops back and forth like a bacon slicer.

Down the right-hand side of the dialog box are scroll bars for each
of the nasties and the Bonus Crystal. Each one controls the
likelihood of a nasty of that type appearing on this wave. At their
left-most, that particular nasty doesn't appear at all on this wave,
and at the right-most, those nasties will m pouring out (up to
the limit set by the Max number of nasties .

If you click on OK, you will return to the wave selection dialog box
shown at the start of this section. If you want to edit another wave
close to this one though, you can click on the OK, Next wave or OK,
Previous wave buttons. These accept the data on the screen and
then go the the wave after or the wave before the current one in a
much speedier way than returning to the other dialog box.

If you hold down the Option key while clicking on the Next or
Previous buttons, the current wave data is copied into the next or
previous wave. This allows you to set up data common to many
waves just once, and then step through the waves, automatically
duplicating it and making any adjustments that you want.
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:6.5) Crystals
The edit window for Crystals is as shown below:

Crystals ( Help ]
Score for each crystal
Twinkling rate
Click on picture to edit: -4 |

. 0K ]
[ Revert to defaults | | Cancel ]

The Score for each crystal is the amount you receive when you
pass over one and take it (remember that this can be negative). The
Twinkling rate only applies when playing the game in color. At the
left-most, the Crystals don't twinkle; at the right-most they flash

Note that the colors in the color image for the crystal will be
constantly modified if it is set to twinkle.
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:6.6) Time bonuses
This window sets the amount of points you get after completing a
wave.

Time bonuses | Help

Time limit for wave #1 T

Max time limit 150 |

Time limit increment per wave 5

Bonus score per second 500

| 0K
[ Revert to defaults || Cancel

Each wave has a time limit, after which no bonus points are
awarded. The Time limit for wave #1 box sets the time limit (in
seconds) for the first wave. The amount is increased by the
number of seconds shown in the Time limit increment per wave
box each wave, up to a maximum value controlled by the Max time
limit box. For each second quicker than the limit that you complete
the wave, you receive the number of points indicated by the Bonus
score per second box.
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:6.7) Smart bombs
Clicking on the this button gives you the window shown below:

Smart Bombs [ Help ]

Number of smarts at start of game

Number of flashes in screen effect |5

Click on picture to edit: n

0K
[ Revert to defaults | | Cancel |

The Number of smarts at the start of game box sets how many
smart bombs you get at the start of a new game (surprise
surprise). The Number of flashes in screen effect box sets how
many time the screen flashes when you let a smart bomb off.
Setting this to a lower value can be particularly useful when playing
in color, as the smart bomb effect can be off-putting.
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:6.8) Explosions
This window lets you change the explosions that appear on the
screen when you have shot and killed a nasty.

Euplosions ( Help

Speed of explosion

Click on pictures to edit:

{ Nl

[ Revert to defaults |[

The explosions consist of three images that are cycled through
and then back to the start again at a rate controlled by the Speed of
explosion bar. With this bar set to the left, each image will stay on
the screen for quite some time, so the explosion will be slow. Set to

the right, the explosion will happen very quickly.

When editing one of the explosion shapes, the speed of the
animation box depends on the current setting of the scroll bar.
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:6.9) Sounds
The sounds window lets you hear and change the sounds used by
Crystal Quest.

Sounds ( Help ]
Got crystal <
You firing I
Gate open i
mrugn g o
Got special bonus i
Killed nasty O
| Play | [ Reed from file | [ Write to file |
| Copy | [ Read Hypercard | [ Write Hypercard | ||
( Paste ][ Sitence ][  Defauit |
| Revert to defaults | | 0K ]

The Initial volume level bar sets the volume level used when you run
Crystal Quest. With the scroll bar at the bottom, the sound is off at
first. When it is at the top, the sound is at maximum volume, and
uses only 2 channels. Anywhere in between sets different volume
levels for 4 channel sound. These settings correspond to hitting

the keys 0 through 9 when in Crystal Quest.

The scrolling list shows you a list of all the sounds used by the
game. Click on the arrows to move up and down the list, or use the
arrow keys on your keyboard. The nine buttons below the list each
operate on the sound currently high-lighted in the list.

Playlets you hear the sound (using only 1 channel - which can be
pretty loud). You can also play a sound by double-clicking on it. If
you hold down the Option key when you click on the play button,
the CritterEditor automatically plays each of the sounds in turn.
Clicking the mouse or hitting a key will stop the process.

Copy copies the sound into the clipboard. The sound can be pasted
back into Crystal Quest or any other program that accepts
standard Apple sound resources (e.g.., Hypercard or the error
sound on a Mac II).

Paste pastes a sound previously copied from Crystal Quest or any
other program that allows sounds to be exported in the standard
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Apple format. The sound is played after it has been pasted. Note
that the CritterEditor will only accept “sampled” sounds, not
those generated by the Mac itself. For instance, the “Monkey”
sound that appears in the control panel on a standard Mac Il is a
sampled sound, and will be accepted, while the “Simple beep” sound
(also in the control panel) is a computer generated beep, and will be
rejected by the CritterEditor. Note also that due to the very specific
nature of the use of sound by Crystal Quest, a sound pasted from
elsewhere may not be played back at the correct pitch.

Read from file lets you replace the selected sound with one stored
as a SoundCap, Audio IFF or Sound Mover file. Clicking on the
button brings up a list of available sound files. Note that the file
cannot be used if it was saved from SoundCap with “Data
Compaction” selected. After the file has been read, the sound is
played. Note also that due to the very specific nature of the use of
sound by Crystal Quest, a sound read from a file may not be played
back at the correct pitch (to be precise, sounds are replayed as if
sampled at 22KHz, regardless of what their actual sampling rate
was). For example, Bill Atkinson's “Hello Everybody”™ sound
sample in HyperCard makes a wonderful critter sound when it's
replayed at 22kHz.

Write to file lets you write a copy of the current sound into either a
SoundCap, Audio IFF or Sound Mover file. Clicking on the button
brings up a “Save as” dialog which also includes buttons to select
between the three formats. The sound can then be used by a
number of other programs.

Read from Hypercard lets you replace the selected sound with one
stored in a Hypercard stack, or in Hypercard itself. Clicking on the
button brings up a list of available stacks and the Hypercard
application. When you select one of these, you are given a list of the
sounds - if any - that are to be found in this file. Holding down the
Option key when clicking this button gives you a list of all files. You
may then open any of them and see what sounds are contained
within them for you to use. An example is the System File - it
contains the 4 standard Apple System beeps on the Mac II.

Wr!hsr to Hypercard lets you write a copy of the current sound into

stack, or into Hypercard itself. Clicking on the button
brrmgs up a list of available stacks and the Hypercard application.
After selecting where you want the sound to go, you are prompted
for a name for the sound. Holding down the Option key when
clicking this button gives you a list of all files. You may then install
the sound into any of them - although very few files will be able to
use this feature. An example of something you can do with this
feature is to add different System Beeps to the System File on a
Mac II
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Don't read or write to Hypercard from the CritterEditor
if you are running under MultiFinder and Hypercard is already
open. Quit from Hypercard first; do the the read or write

operations and then re-run Hypercard.

Warning: Always make sure that the sounds you use in

all have different names from the ones in the System File.
Hypercard and the System Beep (on the Mac II) use a slightly
different sound format. Hypercard searches the System File
before itself when looking for a sound. Because of this, if you have a
sound with the same name in the System File and in Hypercard,
Hypercard will find the System File one first, and fail to play it
because of the different format.

Default reverts just that particular sound to its default.

Silence effectively removes that sound from Crystal Quest
(although why anybody should want to do that, [ can't imagine).

The Revert to defaults button reverts all sounds to their defaults,
but asks for verification first as it's a bit drastic.

Note that there's no Cancel button in this window,

It is important to remember that sound data takes up a lot of disk
space. As soon as you start adding customized sounds to a copy of

Crystal Quest or a parameter file, the size of the file will sky-rocket
instantly.
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:6.10) Demo

The Demo window controls various aspects of the demo that starts
when you hit the D key from Crystal Quest, or when you leave the
game unattended for a while.

Demo ( Help

Start from wave I:I

Time limit 180
——

Auto demo trigger time 120

Fire rate (shots per second) 6

Smart trigger 4

Ship speed E Rl

( 0K
l [ Revert to defaults || Cancel

The Start from wave box sets the wave at which the demo starts.

The Time limit box sets the maximum time (in seconds) that a
demo can run. When this time limit has expired, the demo will
stop.

The Auto demo trigger time box sets the time (in seconds) that the
game can stand idle before a demo will start.

The Fire rate box sets the number of shots, on average, that the
ship will fire per second. Remember that whatever this value is set
to you can only have five of your shots on screen at one time.

The Smart trigger box sets the number of nasties that have to be
on screen at one time before the demo fires a smart bomb. Note
that Dumples and Trimpets are counted as 2 when using this
figure because they can’t be killed as easily as most nasties.

The Ship speed bar controls the speed of the ship as it does the
demo. Note that this is also limited by the Max speed of ship bar in
the Ship window (see section 6.2). By setting both of these bars to
the right, the demo is performed at an awesome pace - so fast that
the ship quite often flies straight through mines (see section 8).
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:6.11) Colors

This edit window can only be brought up when running on a Mac Il
set to 16 or more colors. It allows you to change the colors of
various miscellaneous things, particularly pieces of text, that
appear on the screen. It also allows you to change the color palette
used by Crystal Quest.

The gray squares shown below will be in color on your screen.

Colors Help ]

Underlined items indicate white
l[outer border of title screen
Middle border of title screen
Inner border of title screen
‘Crystal Quest

Double click on a color
to change the palette.

=
Command line
‘Hall of fame'

RS )

[ Revert to defaults | | Cancel ]

The scrolling list on the left hand side of the screen shows each of
the miscellaneous items whose color you can change. Items in
quotes show the actual text of what appears on the screen, for
instance “Hall of fame™, while others give a description, for
instance, “Outer border of title screen”. Each item is shown in the
color that it appears within Crystal Quest, except for white items,
which are shown in underlined black (white doesn’'t show up very
well on a white background you see...).

The current item is shown by brackets either side (see picture
above), and the color of that item is high-lighted in the palette. To
change the color of an item, simply click on a different palette color.

Crystal Quest sets up its own palette of 16 colors, as shown in this
and the graphics editor windows. You can change these colors by
double-clicking on a palette entry in this window. This brings up
the standard Apple “Color Picker” dialog box from which you can
choose a different color. If you change a color, remember that all
instances of this color in the game will change, including
miscellaneous items and images.
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:6.12) Tasks

The tasks window is an advanced part of the CritterEditor which
can radically c e the way in which parts of the game interact.
Crystal Quest divides the program up into tasks, each of which is
shown in this window.

Task periods and phases [ Help ]
Period Phase Period Phase
Ship D Masties check uh]_]
Shots E___“ 0 Nasties creation :l
Objects 2134 Shrapnel TN
2

T

Gateway check Nasty movement |4 i‘:]
Smart bomb 1 n 0 Missiles

Dbstacles check ulﬂ_‘_ Explosions :
Time display I—H_ﬁ'— Move gateway __]

IWARNING! Don't alter these unless you know what you're doing!

| 0K ]
" ( Revert to defaults | | Cancel ]

A task is a particular function of the program that is carried out
periodically while the game is in progress.

Each task has a period and a phase value. The period is the time, in
1/60ths of a second between consecutive executions of that task,
for instance the Ship task usually has a period of 2/60ths of a
second, which means that the part of the program that moves
your ship is called 30 times a second. By changing a value, you can
make a task get called more or less often in relation to the other
tasks.

Each task also has a phase value. This ensures that tasks with the
same period value are not all called at once. This phase value is also
in 1/60ths of a second, and should be less than the period setting.

Each task is briefly described below:

Ship is the task which reads the mouse position and moves the
ship accordingly. Decreasing this value will speed up your
ship.

Shots moves your shots about the screen. Decreasing this value
will speed up your shots.
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Objects checks for intersections with Crystals, Mines, Smart
bombs and Special bonuses.

Gﬂtﬂlﬂﬂgﬂhﬂﬂkﬂhﬂdﬁﬂtﬂﬂﬂﬂwhﬂﬂlﬁrjfﬂuﬂrﬁmmgﬂ through

when it is open.

Smart hamh performs the screen effect for the smart bomb.

Obstacles check checks for collisions with the portals or the
gateway.

Time display updates the time shown in the score line.

Nasties check checks for nasties colliding with you or your bullets.

Nasties creation creates new nasties according to the wave
parameters. Decreasing this value will make nasties appear
more often.

Shrapnel moves the pleces of shrapnel from an exploding
Shrapwarden.

Nasty movement moves the nasties. Decreasing this value will
speed up all nasties.

Missiles moves the nastie's shots. Decreasing this value will speed
up all nastie’s shots.

Explosions cycles explosions through their 3 images. It also
performs the timer for Bonus Crystal score boxes, so
decreasing this period will make those scores stay on the
screen for less time.

Move gateway moves the gateway in waves that specify gate
motion. Decreasing this period will speed up the gateway.

It is worth noting that when the game gets very heavy, particularly

on an older Mac or a Mac II in color, the processor can get bogged

down, and the tasks can't be executed as often as you would like.

‘When this happens, the program tries to even out the calling of the

tasks, so that they stay the same in relation to one another, If

Apple ever introduces a graphics chip that speeds up Quickdraw,

Crystal Quest will really blaze!

7) Short Cuts
There are a number of keyboard shortcuts that you can use:

For all windows Return or Enter correspond to OK and Command-
Period or Clear (Numeric keypad) correspond to Cancel.
Command-? is Help; Command-R is Revert, and Command-D is
Revert to defaults.

On a Crystal Quest window, Command-T is Transfer.

In the Save before Closing/Quitting/Transferring confirmation
dialog, Return or Enter is Yes, Delete isNe and Command-Period
or Clear is Cancel.

Double-clicking on a sound in the Sounds window plays it.
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If the graphics editor window, there are keyboard equivalents for
just about everything:
Command- Z, X, C, V and B correspond to Undo, Cut, Copy,
Paste and Clear.

Command- T, F and A correspond to Copy to..., Copy from...
and Copy to all.

Command- N and P correspond to OK, Next shape and OK,
Prev. shape.

Command- (any arrow key) corresponds to clicking on an
arrow icon (moves shape).

Command- | and | correspond to clicking on the reflect
horizontal and vertical icons.

Command-1 corresponds to clicking on the invert icon.

Command-L corresponds to clicking on the fill icon (color
only).

Command-Tab, Space and Delete set the mode to Paintbrush,
Pencil and Eraser.

In the Get Info window, you can Cut, Copy and Paste text by using
the usual Command-X, C and V combinations.

7.1)Option Key Uses

When clicking on Copy to All in a graphics editor window: only
copies to color or monochrome images in the group, according to
current mode (see section 5).

When clicking on Paste in a graphics editor window: scales the
picture to the maximum size of the image, rather than clipping it
(see section 5).

When clicking on Next Wave or Previous Wave in a wave data
window: copies the data for the current wave over to the next or
previous wave (see section 6.4).

When clicking on Next Shape or Previous Shape in the graphics
editor window: copies the data for the current shape over to the
next or previous shape (see section 5).

When clicking on Play in the sounds window: automatically plays
each of the sounds in turn. Clicking the mouse or hitting a key will
stop the process.

When clicking on Read Hypercard or Write Hypercard in the

sounds window: allows you to select from a list off all files, rather
than just Stacks and Hypercard.

8) Hints, Tips and Caveats

Crystal Quest was designed to work with all of the default settings

intact. As soon as you start changing things, you may find that
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anomalies start creeping in. Casady & Greene Inc. cannot
guarantee that all combinations of parameters will work
satisfactorily together and still produce a fully working game. It is
up to you to change the settings in a constructive manner and still
keep the game playable.

In particular, you will find that if you start making things go too
fast, then collision detection may start to fail. This is because if,
say, your ship and a nasty were heading for each other at high
speed, the game might check for a collision just before should
hit - returning a negative result, and then again just after they
have passed - again returning negative. The effect would be that of

your ship passing through the nasty unharmed.

Another pitfall in building a game is getting carried away with the
sounds. Sounds take an extraordinary amount of space and it is
not at all difficult to build a game that is too big to fit in your
machine. The more sounds you add in or the longer each sound is
the higher the likelihood that your game will get too big to play.

If you find a game is impossible to play, you can always revert to
the default so don't be afraid to change things. Just remember to
keep backups at all times.

Remember that the scores of any or all of Nasties, Crystals and
Bonus Crystals can be made negative if you want. This gives you
scope for some fascinating game configurations. For instance

ving Crystals a negative value would force you to try to make up
or these lost points by completing the wave as fast as you could
and/or shooting as many nasties as possible. Bonus Crystals
could be set to knock off hundreds of thousands of points if you
are unfortunate enough to run into one. Alternatively, Bonus
Crystals could be configured such that their minimum score is,
say, -50,000 but their maximum is 100,000 - this way you are
taking a chance when going for a Bonus crystal that it might
actually lose you points, rather than gain them. By the way, the
current game score can never go negative, it is always rounded up
to a minimum of zero.

After creating a new version of the game, you will probably want to
zero the high score table using Command-Shift-Z, so that you can
start afresh.

Because a saved game can only be registered on the high score
table if it is played using the same parameters as it was saved
under, you may want to include the parameter file’'s name in its
name, for instance if you wanted to save a game at wave 27 using a
parameter file called “Frantic®, you might use the file name
“Frantic.Wave 27°. Alternatively you could create a folder for each
version and place the parameter file and all associated save files in
this folder.
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9) Zen and the art of game design

If you want to make a version of the game that stays fun to play for
some while, rather than just playing around, try to balance things
out. Making the ship smaller can be fun, as you can get through
much smaller gaps. If you do make the ship smaller, the gateway
should also be made narrower to balance the game. If you increase
the points values of nasties and/or crystals, consider increasing
the intervals between bonus lives as well.

You will find that it is particularly difficult to satisfy people with all
levels of skill. A game easy for a four year old won't be interesting
to a 30 year old. On this point, remember to make the game
progressive by careful use of the bonus life bands and the data for
each successive wave.

Crystal Quest is an addictive game because a lot of psychology
went into its design. The secret of an addictive game is the use of
incentive and reward. If you make things too easy or too hard then
you lose this fundamental aspect of the game, and it becomes
boring. After a while playing with the CritterEditor, you will
probably start to appreciate how difficult this balance can be to
achieve.

10) Totally Silly

Totally Silly is a sample parameter file that contains new graphics
and sounds. To see how different Crystal Quest can be just by
changing the graphics and sounds, do the following.

1. If you haven't already done so, make a backup copy of the
master disks

2. Using the copies, double click on the parameter file, Totally
Silly.

3. Select Copy into Crystal Quest in the File menu.

4, Highlight and open the Crystal Quest copy.

5.  Click on the Transfer button.

11) Trying it out.

This section will lead you through a sample session in which you
will make some changes to Crystal Quest, save the changes and
try them out. For simplicity, the example presumes that you're
working on a hard disk.

You're going to change the sound that signifies catching a Bonus
Crystal and the number of Bonus Crystals in wave 1 so you can
hear the sound you just installed.

1. Start the program by double clicking the Crystal Quest
CritterEditor icon.
2. Select New from the File menu. You'll see the following box:
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Choose a subject: [ Trensfer | | Help |
| General | N . | Nasties |
| Wave data | | Crystals | [ Time bonuses |
| Smart bombs | | Enplosions | [  Sounds |
| Demo ] - Ggers . | I'_ Tasks }

3. Click on The Sounds button. Scroll the list to Got Bonus
tal and select it as in the next figure.

Sounds | Help )
No smarts left
Got smart bomb
Dumple absorb
e s tnitial
Trimpet sleep level
Got bonus crystal il »
Time bonus up
Time bonus down
| Play | | Read from file || Write to file |
( Copy ) [ Read Hypercard | [Write Hypercard |

( Paste ][ Silence ][  Defauit |

[ Revert to defauits | [ 0K ]

Click on Read from file.

Open “That’s nice” in the file dialog.

You'll hear the sound when it's installed.

Click Ok. That will return you to the opening dialog box.
Click on Wave Data. ‘That will open the following dialog box.

PNDO; A
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Wave data |

[ Revert to defaults |

9. Click on button 1. That will open the following box.

Data for wave 25 | Help
Number of crystals Annoyer ;E-g
s Worrier i=
NMumber of mines 15 Dumple
Pest
Max number of specials a8 Husket
MaH value of specials 10000 ] Bane
Zarklephaser
MaH number of missiles 15 Menace
Trimpet
Max number of nasties 13 Tentomarsie
Shrapwarden
Smart bomb frequency Parasite

Gateway speed Bonus crystal
([ OK, Newt wave | |

)
[ Revert to defaults | [ OK, Previous weve | | Cancel <3

10. Adjust the Bonus Crystal scroll bar all the way to the right
and click Ok.

11. Select Save into Crystal Quest item in File menu. You'll need
to locate and open a copy of Crystal Quest.

12. When the save is complete, click on the Transfer button to
start Crystal Quest. This version of Crystal Quest that
you've created will have lots of crystals on the first wave.
Every time you catch one, you'll hear the new sound.
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12) Posting Parameter files on Bulletin Boards.
This section will show you how to save your changes in a way that
you can post them on a bulletin board. Since we would like Quest
enthusiasts to purchase Crystal Quest and the CritterEditor, we
ask that you not share modified versions of Crystal Quest.
Instead, you may pass around coples of the parameter files. To do
this, select the Save Parameter Files As... item in the file menu.
When CritterEditor asks you to name the document, type "My
Changes/Shareable.” That will create a parameter file that you
may post on a Bulletin Board. The icon for a parameter file looks

like this:
rriy d\j@“ﬁ

When you are given a parameter file to play with, open the
parameter file using CritterEditor. Then select Save into Crystal
Quest item on the file menu. After the save is finished, click on the
transfer button to play the game. You can save the modified game
for future playing without having to use CritterEditor, we simply
ask that you not pass that game around.

13) Problems

I get beeps instead of sounds.
Make sure the Sound file is in the same folder as the modified
version of Crystal Quest.

I get a message that says “Eek! Out of Memory.”
Sound files can burn up a lot of memory. Try reducing the
number of sounds in your game or shortening the sounds.

If you experience other problems with CritterEditor or don’t
understand how to do something, please contact us at

Casady & Greene Inc.
PO Box 223779
Carmel, CA 93922

(408) 624 8716

Please recognize that the Editor gives you the capability to make
unplayable games. Further, given the large number of variables, we
can't guarantee that every game you create will always work. The
number of cross checks would number in the millions and make
the Editor unusable. Part of the fun in des a game is in
finding that sense of balance that is the hallmark of a good game.
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An award winning Productivity tool from Casady & Greene Inc....

QuickDEX
A Speedy Free-form Database Desk Accessory

HPA4D:0wickDER DwickDER Dala

Find: |data fast|[Dial %0 | Dial+%, |

QuickDEX 15 useful for :
Storing names and sddresses
Inwentores
To Do Lists
Article Abstracts
Telephone dialing
"HIGHEST USER SATISFACTION *
= MACWORLD

‘¢ QuickDEX is a great and versatile program*’

Phillip Robinson called QuickDEX one of his favorite desk accessories that lets you enter any
text or numbers — up to 512 characters per card. When you want to find something, you type
it in the “Find™ window and press Enter. QuickDEX quickly looks through all the cards and
brings up the relevant card. The typical search time is instantaneous, the card appears as soon
as you press Enter. Since QuickDEX is a desk . you can use it within any other
Macintosh program. Find out why QuickDEX won the 1988 Consumer Electronics Showcase
award for Macintosh Productivity software.
Hyperdialer is an external speaker that connects your Macintosh to a touch-tone telephone. It
provides a clean electrical connection that facilitates touch-tone dialing with your Macintosh.
It's easy to install and it works with Multi-line touch-tone telephones..

Books and Stock
We stock Rediform stock for those of you who have difficulty locating it in your area.
Because the Rediform stock is flexible it's easy to use with the ImageWriter,
Easy to Buy - Gt
To order, just call (800) 331-4321 , or in California, (800) 851-1986 .
M

e

Company
Address
City State - T LT
Phone # ( ) - s
i‘;ﬂjﬂmm_
'ﬂty Item Price Sub Total
— QuickDEX (Includes QuickFolder) $60.00
— QuickFolder 2.0 $15.00

HyperDialer (Mot recommended for Mac IT) $39.95

Address Book plus 500 Rediform sheets $25.00

500 Rediform sheets T e ST T N
“Mail to: SubTotl

Casady & Greene Inc. Tax (CA 6%)

P.0. Box 223779 Shipping $4.00

Carmel, CA 93922 C.0D. $2.50

Or Call (800) 331-4321 /[B00) 851 1986 (CA) Total Amount __



